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INTRODUCTION

• It seems like it would be very simple to print something from Excel. 
You just hit Print and you’re done, right?

• Wrong.

• If you don’t format documents properly before you print them they 
will print onto multiple pages when they don’t need to or they’ll print 
without a header row or an identifier column so that you don’t know 
what you’re looking at.

• All of these are easy fixes to learn, but they are absolute musts if 
you’re going to work with Excel to any extent.



WHAT WE’RE GOING TO COVER

• Printing
• Number of copies

• Choice of printer

• Print active 
sheets/workbook/selection

• Print select pages

• Print one-Sided or two-Sided

• Print collated or uncollated

• Print portrait or landscape

• Select paper type

• Print margins

• Scale page

• Page Setup

• Print Titles



INTRODUCTION

• This course is part of the Easy Excel Essentials series of courses and is 
based on the books of the same name.

• Each course is meant to cover one specific topic.

• The assumption is that you already familiar with Excel but want to 
broaden your understanding in that one area.

• The videos in this course are extracted from the course Excel for 
Beginners by M.L. Humphrey which provides a broader coverage of 
introductory Excel topics. (Links and discount codes at 
mlhumphrey.com)



INTRODUCTION

• I’m using Excel 2013 for this course

• It should look familiar to users of Excel 2007 or later

• What qualifies me to teach this course:

• I have an Econ degree from Stanford and an MBA from Wharton.

• More importantly, I’ve been using Excel for over twenty years in a personal 
and professional capacity.



PRINTING



PRINTING

• It’s important if you plan on printing something you’ve created in 
Excel that you preview the document to make sure it’s going to look 
like what you want.

• Common issues with printing include data that runs off the edge of 
the page, a lack of headers or column numbers past the first page, a 
lack of borders to clearly separate the data, and a lack of page 
numbers.

• Also, you may want to choose to print on both sides of the page or on 
a different size paper than normal. All of that can be addressed in the 
print settings.



PRINTING (Cont.)

• You can access the print screen by either using Ctrl + P or by going to 
the File tab and selecting Print.

• If there’s nothing that you want to change (maybe this is a document 
you’ve printed before that’s already formatted), you can click on the 
large Print icon at the top of the screen.

• I recommend at least looking at the document preview which is 
shown to the right of the print options and takes up most of the 
screen. This shows you how your document will print on each page.



PRINTING (Cont.)

• There are a number of options for changing that appearance as well 
as selecting the paper type, whether your document will print on one 
side of the page or two, and how multiple copies will print. It’s easiest 
to just walk down the list and discuss each option as you see them on 
the screen.



Number of Copies

• Right at the top of the screen next to the Print icon is an option for 
selecting the number of copies you want to print.

• Use the up and down arrows to select the number of copies you 
want.

• Or you can simply type the number into the box.



Printer

• Excel will display the default printer or the last printer used as your 
chosen printer.

• If you want to select a different printer, click on the arrow next to the 
printer name and choose from the dropdown menu.

• If the printer you want isn’t listed, you can choose Add Printer at the 
bottom of the list and add the printer you want.



Print Active Sheets / Print Entire 
Workbook /Print Selection

• The default is for Excel to print the worksheets you have selected. 
(You can select more than one worksheet by holding down the Ctrl 
key as you click on the worksheet names.)

• You can also choose to print the entire workbook which will print all 
of the worksheets in your document.

• Or, if you’ve highlighted a section of a worksheet, you can choose to 
print that selection only. (There’s another option for this called Print 
Area, that we’ll discuss later.)

• Be careful if you print multiple worksheets or the entire workbook 
because your headers/footers will be affected.



Print Selected Pages

• This is something I use more in Word than Excel, but if you’re looking 
at the preview of your document and realize that you only want a 
specific subset of the pages you’re seeing in the preview, you can 
choose which pages to print here.

• Unlike in Word, you have to print a page range. You can’t print page 1 
and then page 3.

• To choose the page numbers to print, use the preview and then 
change the numbers next to Pages.



Print One Sided / Print on Both Sides 
(Long Edge) / Print on Both Sides (Short)

• The default is for Excel to print on one side of the page, but if you 
have a printer selected that can print on both sides of the page, you 
will have the option to print on both sides of the page.

• Choose to print on both sides and flip on the long edge if you’re 
printing in portrait mode. (Which is what you’ll normally be doing.)

• Choose to print on both sides and flip on the short edge if you’re 
printing in landscape mode. (We’ll discuss these in a moment.)



Collated / Uncollated

• This only matters if you’re printing more than one copy and your 
document has more than one page.

• If you want to print one full copy of the document at a time and print 
that x number of times, then choose collated.

• If you want to print x copies of page 1 before you print x copies of 
page 2, etc. then choose uncollated.

• Unless each page of your document is meant to be an individual 
handout, you’re better off with the collated option.



Portrait Orientation /
Landscape Orientation

• You can choose to print in either portrait orientation (with the short 
edge of the page at the top and the long edge along the side like most 
reports and books) or in landscape orientation (with the short edge of 
the page along the side and the long edge along the top like many 
PowerPoint presentations).

• Which option I choose depends on how many columns of data I have 
versus how many rows. If I can fit all columns onto one page by using 
landscape, I will. If I only have a few columns, I’ll stick with portrait.



Letter / Legal / Statement / Etc.

• The next option you have is what paper you’ll be printing on. Unless 
you’re in an office or located overseas, you’re generally going to 
default to 8.5” x 11” paper. Most offices also carry legal paper. Some 
carry even larger sizes. Overseas the default may be A4.

• Usually, this is set to what you need. So you’ll only be using it if you’re 
in a situation where you know your paper type needs to differ from 
the standard option for your location.

• Click on the dropdown to see the many, many choices you have.



Normal Margins / Wide Margins / Narrow 
Margins / Custom Margins

• Margins are the space around the edge of the page. My version of 
Excel uses .7” on the sides and .75” at the top and bottom of the 
page.

• I would expect you won’t need to change this, but if you do need 
wider or more narrow margins than Excel’s default this is where you 
can do it.

• (There are better ways to make your data fit on one page that we’ll 
discuss in a moment.)



No Scaling / Fit Sheet On One Page / Fit 
All Columns on One Page / Fit All Rows

• I use this one often.

• If you have a document where maybe just one column continues on 
to the next page or just one row does, you can scale the document to 
make sure that all of the columns or all of the rows will fit on that one 
page.

• Choose Fit All Columns on One Page and Excel will reduce the font 
size of your text so that all columns you’re going to print fit on a page. 
You may have multiple pages still because of the number of rows, but 
all the columns will be on that one page.



Scaling (Cont.)

• The same holds true for Fit All Rows On One Page. You may have 
multiple pages because of the number of columns, but all rows will be 
fit onto that page.

• Fit Sheet On One Page fits all rows and columns onto one page.

• Of course, you need to exercise a bit of caution here. Because Excel 
doesn’t take into account whether the final document will be legible. 
It could fit a hundred columns on a page. You just won’t be able to 
read it.

• Definitely preview your document if you’re using scaling.



Page Setup

• Most of what you need will be available in the options we already 
covered, but the Page Setup dialogue box does contain a few more 
that are useful.

• Scaling: On the Page tab you can be even more specific about your 
scaling. You can choose the exact number of pages wide or long your 
document should be. So if you have a four page document where 
page 4 is just one line of text, you can scale that document to be 
three pages long instead. Very useful.



Page Setup

• Center Horizontally or Vertically: On the Margins tab you can choose 
to center your text either horizontally or vertically. I often choose to 
center my text vertically when it doesn’t stretch across the entire 
page. Otherwise it tends to look off-balance.

• Header/Footer: I usually do this a different way that we’ll talk about in 
a minute, but on the Header/Footer tab you can choose from a 
number of pre-formatted headers and footers. You can also create 
your own.

• Rows and Columns to Repeat: The Sheet tab allows you to specify 
rows or columns to repeat on each page, but I do this differently.



Page Layout Tab – Print Area

• If you only want to print a certain portion of a worksheet, you can 
define a print area by highlighting it, clicking on the arrow next to 
Print Area in the Page Layout tab, and choosing Set Print Area.

• Once this is set, anything else that you add to that worksheet outside of that 
area will not print unless you select it and choose to print the selection.

• It’s very useful if you have side calculations you never want to print or you 
formatted an entire row or column accidentally and don’t want to change it, 
but dangerous if you have a document that will change over time and forget 
you did this.

• If you had set a print area and need to remove it, go back to the Print Area 
dropdown and choose Clear Print Area.



Page Layout Tab – Breaks

• You can specify exactly where a new page will begin using Breaks.

• I honestly don’t use them often, but they can be useful if you have 
specific rows or columns that must stay together.



Page Layout Tab – Print Titles

• This one is incredibly useful.

• Click on Print Titles under the Page Layout tab and it will bring up the 
Page Setup dialogue box. But because you’re in the document, right 
now you can easily just highlight rows or columns to repeat rather 
than have to remember the notation for a row or column.

• Rows to Repeat At Top allows you to tell Excel which row in your 
document is a header row that labels your data. If your data 
continues on to more than one page, you’ll want to do this so that 
when the document is printed you know what you’re looking at.



Print Titles (Cont.)

• Columns To Repeat At Left does the same thing but for columns. So if 
your data is long enough to continue onto a second page, it’s often 
useful to repeat the first few identifying columns on each page. (Like 
item number or customer name or student name.)

• To use either one, click into the white box and then click on either the 
column letter or the row number for the column or row you want to 
have repeat.

• If you decide to have more than one row or column repeat, be sure 
that they don’t take up so much of the page that you basically end up 
printing just the header rows or columns over and over again.



CONCLUSION



CONCLUSION

• So that was how you print from Excel. Not too hard to do, but 
absolutely essential to get right.

• If you get stuck, reach out to me at mlhumphreywriter@gmail.com
and I’m happy to help.

• And if you want to cover more Excel topics, then drop by my website 
for links to other classes and/or books on Excel at 
www.mlhumphrey.com.

mailto:mlhumphreywriter@gmail.com
http://www.mlhumphrey.com/

